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THE INTERFACE 
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1.1 MAIN WINDOW

This is the window that comes up on starting the application. 

appear for a brief moment before the main window shows up.

 

 

 

 

The main window looks like most other application windows and is composed of a menu

toolbars, the control panel and a rendering area called the rendering canvas or simply canvas. 

As is common, the menu-bar

1.1.1 PANELS 
The various sub-windows that may appear 

One important panel is the 

It’s the only panel that may be docked into the main window

dataset list the plot list and the plot controls. 

means to manipulate opened files and the 

panels for individual imaging algorithms are explained in their respective sections in chapter II.
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INDOW 
This is the window that comes up on starting the application. A small

for a brief moment before the main window shows up. 

The main window looks like most other application windows and is composed of a menu

toolbars, the control panel and a rendering area called the rendering canvas or simply canvas. 

bar and the toolbar are located near the top of the main window. 

windows that may appear when performing different 

One important panel is the Control Panel (§1.4) which appears in the main window by default.

It’s the only panel that may be docked into the main window. The control panel 

and the plot controls. These provide important information and the 

means to manipulate opened files and the output of various imaging algorithms

panels for individual imaging algorithms are explained in their respective sections in chapter II.

Figure 1.1 - The Main Window 

1. Menu-bar 

2. Toolbar 

3. Control Panel 

4. Rendering Canvas 

5. Status-bar 
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A smaller splash window may 

The main window looks like most other application windows and is composed of a menu- bar, 

toolbars, the control panel and a rendering area called the rendering canvas or simply canvas. 

the top of the main window.  

when performing different tasks are called panels. 

he main window by default. 

. The control panel displays the 

provide important information and the 

algorithms. The different 

panels for individual imaging algorithms are explained in their respective sections in chapter II. 
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1.2 MENUS  
This section lists the various menus and their function in brief along with other useful info. 

1.2.1 FILE MENU 
Open - [Ctrl+O] 

Brings up the open file dialog box. If any file is open at the time, the program will warn with a 

message box that opening a new file will close the current one. To continue to open a new file, 

one must confirm by clicking on the OK button. To know about the types of files and datasets 

supported by this edition of ViewZ see §1.6. 

Close - [Ctrl+C] 

Closes any file that’s open at the time. 

Capture screen  

Saves the image on the rendering canvas to disk in either PNG or TGA format. 

Import Data for Graph 

Brings up the Import Graph Data File panel (§3.1).  

Recent Files 

Displays a sub-menu which lists a few of the files that were loaded recently. Clicking any of the 

entries on this sub-menu will load that particular file. Pressing the F5 key will re-load the most 

recent file. This feature may be configured from the User Preferences panel (§3.3). 

1.2.2 EDIT MENU 
Preferences 

Brings up the Preferences panel (§3.3).. 

1.2.3 VIEW MENU 
Fullscreen - [F11] 

Toggles between normal and full-screen window modes. This applies only to the main window. 

Perspective/Orthographic Mode - [Ctrl+M] 

Toggles between perspective and orthographic projection modes of rendering. When in 

orthographic mode this menu item will show the text Perspective Mode indicating that clicking 

on it will change the projection mode to perspective and vice versa. 

Reset View - [Q] 

Resets the view and zoom level so that the object origin is centred to the screen with the 

positive z-axis pointing outwards from the screen. 

Isometric View - [W]  

Sets the view so that the object is seen at and isometric orientation. 

Zoom in - [Z]  

Zooms into the current view. 

Zoom out - [X] 

Zooms out of the current view. 
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Front view - [F] 

Sets the current view so that the positive z-axis is pointing outward from the screen. 

Back view - [E] 

Sets the current view so that the negative z-axis is pointing outward from the screen. 

Top view - [R] 

Sets the current view so that the positive y-axis is pointing outward from the screen. 

Bottom view - [V] 

Sets the current view so that the negative y-axis is pointing outward from the screen. 

Left view - [D] 

Sets the current view so that the negative x-axis is pointing outward from the screen. 

Right view - [G] 

Sets the current view so that the positive x-axis is pointing outward from the screen. 

1.2.4 DATASET MENU 
Extract Dataset 

Brings up the Extract Dataset (§3.2.1) panel. This is available only for 3-D datasets. 

1.2.5 PLOTS MENU 
Boundary Plot - [Ctrl+1] 

Brings up the New Boundary Plot panel that allows addition of boundary plots (§2.5) to available 

boundaries on a 3-D dataset. 

Labels - [Ctrl+2] 

Brings up the panel that allows addition of label plots (§2.6) to the labels specified for the 

object. This is available only for 3-D datasets. 

Colour Plot - [Ctrl+3] 

Brings up the Colour Plot Options panel that allows addition of colour plots (§2.7) to a surface. 

This is available only for 2-D datasets. 

Section Plane - [Ctrl+4] 

Brings up the New Section panel where parameters for the section plane (§2.8) to be added to 

the domain may be specified. This is available only for 3-D datasets. 

Vectors - [Ctrl+5] 

Brings up the Vector Plot panel (§2.9) that allows adding vector glyphs to the dataset. 

Iso-lines - [Ctrl+6] 

Brings the Iso-line Options panel that allows addition of iso-lines (§2.10) to the dataset. This is 

only available for 2-D datasets. For iso-lines on 3-D datasets see §2.8.1. 

Iso-surfaces - [Ctrl+7] 

Brings up the Iso-surface Options panel that allows addition of an iso-surface (§2.11) to the 

dataset. This is only available for 3-D datasets. 

 



 

 

Streamlines - [Ctrl+8] 

Brings up the Streamlines panel that allows addition of streamlines (§

dataset. This is available only for 3

Surface Streamlines 

Brings up the Surface Streamlines

(§2.13) may be chosen. 

1.2.6 DATA PROBE MENU 
The commands in this menu are only available for 3

Line Probe 

Brings up the Line Probe (§3.4) panel.

Line on Surface Probe 

Brings up the Line on Surface Probe

Point Probe 

Brings up the Point Probe (§3.6) panel.

1.2.7 WINDOW MENU 
This menu contains commands that allow controlling the visibility of

control panel. 

Control Panel 

Shows/hides the Control Panel (§1.4)

indicate that the control panel is visible.

 

Toolbars 

This menu entry leads to a sub-menu with commands that 

1.2.8 HELP MENU 
Provides commands for invoking the user manual and the about box.

Contents - [F1] 

Invokes the browser to open the HTML help contents page. For this 

used must be specified in the User 

About 

Displays the about box with some information about the program version.

1.3 TOOLBARS 
Toolbars provide shortcut buttons to frequently used functions. There are two toolbars on the 

main window – File Management and 

1.3.1 FILE MANAGEMENT 

 Open File
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panel that allows addition of streamlines (§2.12) to the current 

only for 3-D datasets. 

Surface Streamlines panel where the surfaces for plotting these

The commands in this menu are only available for 3-D structured datasets.  

) panel. 

Line on Surface Probe (§3.5) panel 

panel. 

This menu contains commands that allow controlling the visibility of the toolbars and the 

(§1.4). A check mark by this menu entry will be present to 

control panel is visible. 

menu with commands that show/hide individual toolbars.

invoking the user manual and the about box. 

Invokes the browser to open the HTML help contents page. For this to work, the browser to be 

 Preferences panel (§3.3). 

Displays the about box with some information about the program version. 

Toolbars provide shortcut buttons to frequently used functions. There are two toolbars on the 

and View Controls. 

Open File - [Ctrl+O] 

) to the current 

these streamlines 

the toolbars and the 

. A check mark by this menu entry will be present to 

show/hide individual toolbars. 

the browser to be 

Toolbars provide shortcut buttons to frequently used functions. There are two toolbars on the 



 

 

1.3.2 VIEW CONTROLS 

 

 

 

 

 

 

 

 

 

 

 

 

1.4 CONTROL PANEL

The control panel is the most useful panel on the main window. It provides two lists that keep 

track of all operations performed and the ability to manipulate parameters of various plots 

added during the session. 

1.4.1 THE DATASETS LIST

A list of datasets opened is maintained here. 

one dataset to be open in one instance, t

Line Probe (§3.4) and XY plots

column that shows the na

dataset. 

In case of multiblock datasets, double clicking on the dataset entry will expand the list revealing 

blocks within.  

Seeing Dataset Details 

Right click on entries in this list and select 

related information. 

1.4.2 THE PLOTS LIST 
All plots added to the dataset are listed here and the panels for manipulating t

brought up by double clicking

associated with it that controls visibility of that plo

plot in the rendering canvas.

plot and the Type column that indicates the type of the plot.

Context menu options 

Right click on a list entry to 

allow renaming a plot, a Details

the plot and a Properties command which has the same effect as double clicking on the entry. 

Chapter I 
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Reset View - [Q] 

Isometric View - [W] 

Zoom In - [Z] 

Zoom Out - [X] 

Front View - [F] 

Back View - [E] 

Top View - [R] 

Bottom View - [V] 

Left View - [D] 

Right View - [G] 

Toggle Block Boundaries  

Capture Screen  

ANEL 
The control panel is the most useful panel on the main window. It provides two lists that keep 

performed and the ability to manipulate parameters of various plots 

 

IST 
A list of datasets opened is maintained here. Although the current version of ViewZ only allows 

one dataset to be open in one instance, this list also displays runtime generated datasets form 

XY plots (§2.14) and others. There are two columns in this list

ames of the dataset and a Type column that indicates the type of 

of multiblock datasets, double clicking on the dataset entry will expand the list revealing 

Right click on entries in this list and select Details from the context menu to see dataset

All plots added to the dataset are listed here and the panels for manipulating t

clicking on the corresponding list entry. Each entry has a check

associated with it that controls visibility of that plot. Un-checking this will hide that particular 

plot in the rendering canvas. There are two columns in this list, a Plot 

column that indicates the type of the plot.  

Right click on a list entry to bring up the context menu. It contains a 

Details command that brings up a dialog with some 

command which has the same effect as double clicking on the entry. 

Chapter I – The Interface 

The control panel is the most useful panel on the main window. It provides two lists that keep 

performed and the ability to manipulate parameters of various plots 

Although the current version of ViewZ only allows 

his list also displays runtime generated datasets form 

There are two columns in this list, a Dataset 

column that indicates the type of 

of multiblock datasets, double clicking on the dataset entry will expand the list revealing 

from the context menu to see dataset/block 

All plots added to the dataset are listed here and the panels for manipulating them may be 

Each entry has a check-box 

checking this will hide that particular 

 column that names the 

It contains a Rename command that 

command that brings up a dialog with some information about 

command which has the same effect as double clicking on the entry.  
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Default Plots 

On opening a dataset file, a few plots 

are added by default to the plots list. 

These are: 

1. The Legend (§2.1) 

2. Main outline (an outline plot, §2.2) 

3. A Text plot (§2.4) indicating the 

file-path of the dataset opened. 

Additionally: 

4. Main mesh (a mesh plot, §2.3), in 

case of unstructured datasets. 

5. Boundary plot (§2.5) in case of 3-D 

unstructured datasets. 

1.4.3 PLOT OPACITY CONTROL 
This slider allows changing the opacity 

of plots. To change the opacity for a 

plot, select its entry in the plots list and 

drag this slider till the desirable effect 

is achieved. This is available only for 

some of the plots and will be disabled 

for others. 

1.4.4 QUICK SCALAR PICKER 
This dropdown list enumerates the 

various scalar fields for which data is 

available in the dataset opened. It may 

be used to select that scalar that any 

plot is to be coloured by. Most plots have a similar scalar picker n their properties panel. The 

QSP is meant to be a short-cut method for changing the colouring scalar. To switch the colouring 

scalar for a plot, select its entry in the plots list and then select the desired scalar using the QSP. 

1.5 RENDERING CANVAS 
This is the 3-D viewport on the main window where all the graphical results are drawn. ViewZ 

uses OpenGL for drawing.  

1.5.1 INTERACTING USING THE MOUSE 
It is possible to use the mouse to perform some very frequently performed actions on the 

rendered dataset. These are: 

Panning 

Drag within the rendering canvas with the LMB to move the object in plane of the screen. 

Rotating 

Drag within the rendering canvas with the MMB to rotate the object about its origin. 

 

Figure 1.2 - The Control Panel 

Datasets List 

Plots List 

Plot Opacity Control 

Quick Scalar Picker 
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Zooming 

Drag within the rendering canvas with the RMB to draw a zoom window. Releasing the RMB will 

cause the view to zoom into the specified zoom window.  

1.6 FILE SUPPORT 
ViewZ currently supports datasets written in the CGNS (CFD General Notation System) file 

format. Furthermore, only the following types of datasets are supported: 

• 2-D Structured datasets 

• 2-D Unstructured datasets 

• 3-D Structured, single and multi block datasets 

• 3-D Unstructured, single and multi block datasets (tetrahedron and hexahedron cells). 
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Everything that is drawn in the rendering area is a plot. Each of these may be manipulated via 

their respective panels which may be invoked by double clicking the plot entry in the plot list. 

This chapter explains all the available plots and their panels.   

2.1 LEGEND 
The legend displays the colour-map being used for showing scalars in 

other plots along with calibration markings. This plot is added 

automatically by ViewZ whenever a dataset is opened and there can be 

only one instance of the legend on the rendering canvas.  

Legend Options 

Double clicking on the legend entry in the plots list brings up the Legend 

Options panel. This panel allows setting the number format to either 

standard or scientific and it allows setting the precision and the number 

of calibration markings. 

2.2 OUTLINE PLOT 
The outline plot for a dataset (main outline) displays a bounding box 

about the domain. For multiblock datasets an outline plot is added for 

each block and displays the block outline instead of a bounding box 

around it. The outline plot for the dataset is listed in the plots list (§1.4.2) 

and may be turned off by un-checking it. Plot list entries for outline plots for individual blocks 

may be seen when the corresponding block is selected in the expanded dataset list (§1.4.1). 

These are un-checked by default and must be made visible by hand. All outline plots are added 

automatically when a dataset is opened. 

2.3 MESH PLOT 
Added by default for unstructured datasets, a mesh plot renders the mesh lines in the dataset. 

By default the mesh plot is rendered with opacity of 15%. This may be changed by using the 

default mesh opacity setting in the User Preferences panel (§3.3). 

2.4 TEXT PLOT 
For displaying text on the rendering 

canvas, text plots may be used. To add a 

text plot, select the Text Plot command 

from the plots menu. The text plot 

properties panel may be brought up by 

double-clicking the corresponding entry 

in the plots list. The font, font size and 

colour for the text may be specified using 

the properties panel as well as the text to 

be displayed itself may also be edited 

here. The positioning of the text plot may be done by clicking on the Move button. This 

Figure 2.1 - Legend 

Figure 2.2 – Text plot settings 
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temporarily hides the properties panel and allows one to use the mouse to move the text on 

screen. Click with the LMB on the desired point in the rendering area where the text plot is to be 

located. 

2.5 BOUNDARY PLOT 
Boundary plots visualise boundary conditions. It is available via the New Boundary Plot panel 

that may be invoked from the Plots menu. This panel lists the available boundaries and to add 

one, select it from the list and click on the Add button. Multiple plots may be added this way. 

Each boundary plot added is listed in the plots list in the control panel. 

2.5.1 VISUALISING SCALARS ON THE BOUNDARY 
A newly added boundary plot is by default shaded with a constant colour. To change this, 

double-click on its entry in the plots list to bring up the Boundary Plot Settings panel. Here 

among other parameters, one may specify the scalar quantity that the boundary should be 

coloured by. A drop down list allows selection of the desired scalar. Ensure that the Show Scalar 

check box is checked. Now click Apply or OK to save this change. 

2.6 LABELS 
Labels are specified during the grid generation stage. They are used to identify boundary faces 

having the same boundary type and conditions. Label plots allow visualisation of these labels. 

To add a label plot invoke the Labels command from the plots menu. The New Label Plot panel 

lists the labels that are available and to add a plot for any of these, select it in the list and click 

the Add button. 

2.6.1 VISUALISING SCALARS AND ISO-LINES ON LABELS 
Double-click on the label plot entry in the plots list to invoke its properties panel. Here select 

the desired scalar quantity in the Choose Field drop down list. Iso-lines may also be shown on 

labels. To enable them, enter the number of lines that must to be shown in the Number of 

contours field and click the OK button. 

2.7 COLOUR PLOT 
Available for 2-D datasets, this plot colours the surface by a specified scalar. To add a colour 

plot, invoke the Colour command from the plots menu. Only the scalar to use for colouring needs 

to be specified when adding this plot. Double clicking its plot list entry brings up the properties 

panel where the scalar being may be changed. 

2.8 SECTION PLANE 
The Section Plane plot allows us to define arbitrary planes and visualize values that have been 

sampled on the plane. Section planes may be added via the Section Plane command in the plots 

menu. This command brings up the New Section panel where the coefficients of the plane 

equation may be specified along with the scalar that the section must be coloured by. Click OK to 

add the section plane. Its entry will be added to the plots list. To further modify its parameters, 
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the Section Options panel may be brought up by double-clicking the corresponding section plane 

entry in the plots list. 

Specifying the plane 

ViewZ requires the section plane to be specified by the coefficients of the plane equation. These 

are to be entered in the A, B and C fields on the panel. A parameter D specifies the amount by 

which the plane should be translated along its normal. These coefficients may also be modified 

from the properties panel for the plane. 

 

 

 

To move the plane along the normal, the slider 

in the Move Section area (figure 2.4) in the 

section properties panel may also be used. 

 

 

 

2.8.1 VECTORS AND ISO-LINES ON A SECTION PLANE 
The Plot on Section area in the section properties 

panel can enable visualisation of iso-lines or 

vectors in the section. By default a colour plot is 

shown on the section. To see either vectors or iso-

lines on the section select the appropriate radio 

button. The Options button allows additional 

parameters for iso-lines of vectors to be modified. 

Clicking options for iso-lines brings up a dialog box 

where the number of levels may be specified. For 

1. Specify plane equation coefficients 

2. Select the scalar by which the section must be coloured by 

Figure 2.3 – New Section panel 

Figure 2.4 – Move Section 

Figure 2.5 – Plot on Section 
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vectors the Options button brings up the vector properties panel which is explained in §2.9. 

The Show Section checkbox may be used to show or hide the actual section while plots over it 

remain visible. Un-checking this hides the section. 

2.9 VECTORS 
To visualise vectors add a vector plot to the dataset by invoking the Vectors command from the 

plots menu. This command brings up the Vector Plot Properties panel where the various 

parameters for the plot may be specified.  

In the Vector tab 

Components - Specify the three components for 

the vectors here. Vector Origin - Specify the 

point from where the field values are to be 

taken for computing the vectors. If set to 

Vertices, field values at vertices will be used. 

Similarly when set to Cell Centres, field values 

at cell centres will be used. It is possible to 

visualise vectors at points in generated 

datasets. To do this set vector origin setting to 

the third option of User defined lines. A 

generated dataset must be present before 

doing this. Click on the Set button in the Vector 

Data Source area to select from the available 

generated datasets. 

In the Render tab 

Vector Length 

Allows control of the length of the vector glyphs 

rendered.  

Available settings: 

• Adapt to cell size - Glyphs are sized 

according to cell size 

• Fixed Max. - Maximum magnitude is fixed 

• User defined - The vector length can be 

defined 

Vector Colouring 

• Proportional to magnitude - Colours are 

assigned depending on vector magnitude 

• Constant colour - All glyphs are coloured 

by one specified colour. 

Clicking the Advanced button will bring up the 

Additional Vector Properties panel. The 

parameters on this panel are: 

Figure 2.6 – Vector tab 

Figure 2.7 – Render tab 
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In the filters tab 

Show Vectors - Specify a threshold value in the provided field that's inside the displayed 

minimum and maximum range and select one of the radio buttons to see only those vectors that 

are either above, below or equal to the set threshold value. 

When viewing vectors on a section the Vector on Section Options area will be enabled and it is 

possible to set the glyphs to be projected onto the section. Use the Show Projection on Section 

checkbox to enable this. When this checkbox is checked, the projections of the glyphs on the 

section are rendered. 

In the Advanced Rendering tab 

Vector Length Ratio 

The min. to max. vector length ratio may be fixed by setting an appropriate value here. 

Vector rendering 

Controls how the glyphs are drawn 

Available settings: 

• Cone with stem - Glyphs are drawn as a cone on a cylinder 

• Cone without stem - Glyphs are drawn as cones 

• Arrow - Glyphs are drawn as line arrows. This option offers the best performance. 

Vector Base Radius 

When vector rendering is set to something other than Arrow, this area is enabled and the base 

radius of the cone and stem may be controlled using these settings. 

Available settings are: 

• Vary by cell size - Glyph radius is automatically sized in proportion to the cell size. 

• Percent of vector length - Glyph radius is computed as a fraction of its length. The 

fraction may be specified in the provided field. 

2.10 ISO-LINES 
Available for 2-D datasets, iso-lines are lines that connect points of equal value on a surface. 

Invoking the Iso-lines command from the plots menu will bring up the Iso-line Options panel 

where the scalar and the number of iso-lines to be drawn can be specified. There is also a range 

control where it is possible to specify a smaller range within the field minimum and maximum 

for the iso-lines. The lines are by default set to be coloured by the selected scalar itself and may 

be set to a constant colour. Iso-lines are best viewed over a colour plot of the same scalar. 

2.11 ISO -SURFACES 
Available only for 3-D datasets, an iso-surface represents points of a constant value within the 

given volume data. To add and iso-surface plot, select the Iso-surfaces command from the plots 

menu. This will bring up the New Iso-surface panel where desired scalar field and the iso-value 

in that field for the new iso-surface may be specified. This panel also displays the minimum and 

maximum values in the field. On clicking OK the new surface will be computed and rendered. In 

case no such surface is found, nothing new will be rendered on screen. 
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Further parameters for the iso-surface may be modified from its properties panel which can be 

brought up by double-clicking on the plot’s entry in the plots list (§1.4.2). In addition to 

modifying the field and iso-value the properties panel also allows changing the scalar by which 

the surface is coloured. This way the variations of other scalars may be visualised on an iso-

surface. 

2.12 STREAMLINES 
ViewZ supports visualising streamlines for 3-D datasets. To add streamlines to a dataset, click 

on the Streamlines command in the plots menu. This command will bring up the streamlines 

panel where parameters for rendering can 

be specified. 

Seed positioning 

Seed points for the streamlines can be 

arranged as a grid or in a circular of 

elliptical manner. In each case a reference 

point has to be specified about which the 

rest of the points are created. To specify 

the reference point either enter it’s 

coordinates into the fields or use the 

nudge scrollbars to position the point at 

the desired location. The three smaller 

sliders may be used to rotate the array of 

points as desired. 

In the Parameters section, the Seed 

Dispenser Type drop-down list allows one 

to select the arrangement of points 

desired. For each type of arrangement, 

parameters fields specific to it will be 

shown. When Grid arrangement is 

selected, the number of points in three 

directions and the distance between 

consecutive points may be specified.  

For circular and elliptical arrangements, 

the reference point acts as the centre and 

the seed points are drawn around it. For 

both these arrangements the following 

parameters may be set: 

• Number of points to be created. 

The points are placed along the circumference. 

•  Start and End Angles, for creating points only along a section of the circumference in 

degrees. 

• Radius of the circle. In case of an ellipse, the semi-major and semi-minor axes are to be 

specified. 

• Number of Disks specifies the number of such circular or elliptical disks to be created. 

Figure 2.8 – Seed positioning for streamlines 

1. Nudge-bars, use these to position the 

reference point. 

2. Use these controls to orient the array of 

points. 
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• Inter Disk Distance is the distance between each disk of points in case there’s more than 

one. 

• Angle Step in degrees is added to the start and end angles for each consecutive disk of 

points created. 

On clicking Apply, the streamlines will be drawn if any of the start points lie in a region that has 

velocity components. If there are no velocity components near the point then just the point will 

be seen without any streamline. Keeping the auto update checkbox checked will cause 

streamlines to be redrawn every time its seed points are moved. 

When available, the Options tab provides two 

more parameters that can be adjusted. One is 

the Step Size parameter which is the amount 

of time for which the streamline should 

advance per step. This parameter may be 

adjusted to get smoother streamlines. The 

other parameter is Time steps which is the 

number of such advances the streamline will 

make. 

2.13 SURFACE STREAMLINES 
Streamlines showing the flow very close to the surface can be seen using surface streamlines. To 

plot these lines, invoke the Surface Streamlines command from the Plots menu. This will bring 

up the panel that allows one to select from a list of labels and boundaries in the dataset, on 

which to draw these lines. Once the desired surfaces are selected, click OK to see the lines. 

Double-clicking on the plots list (§1.4.2) entry for surface streamlines will bring up its 

properties panel where further options to modify the plot are available. The surface streamlines 

plot is currently available only for 3-D unstructured datasets. 

2.14 X-Y PLOTS 
These are 2-D graph plots that can be plotted for 

point’s generated using the Line Probe (§3.4) 

command. To add an X-Y plot, the data for which 

plots are needed must be imported using the 

Import Data for Graph (§3.1) command in the file 

menu. Once the plot is added, the rendering canvas 

will display a preliminary graph and the X-Y Plot 

Properties panel will also be visible. 

The X-Y plot Properties panel has four sections that may be selected using the drop-down list at 

the very top. 

Rendering 

In the Rendering section, options for setting properties about how the plot lines and the legend 

are to be rendered are available.  It is possible to render the plot as lines, points or filled area. 

Figure 2.10 – Switch sections 

using the drop-down list. 

Figure 2.9 – Auto update 
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Options are also available to modify the way the lines, points or filled area is drawn. The 

position of the legend can set to top left, top right, bottom left or bottom right. 

Variables 

A list of variables for which data is available is shown in this section. From here it is possible to 

control which variables are plotted, rename them in the legend and change their plot colour. It 

is also possible to change the independent variable for the plot. 

Position and size 

Settings available in this section allow the plot area to be resized as needed and repositioned 

anywhere within the rendering canvas. Two sliders are available that allow the plot area to be 

resized. Clicking on the Move using Mouse button will temporarily hide the panel and allow 

repositioning the plot area within the rendering canvas. When doing this, an empty rectangle 

represents the complete area of the plot. Position this rectangle at the desired location and click 

with the LMB on the rendering canvas to set the x-y plot at that location. After clicking, the 

properties panel will reappear. 

Common 

This section has some additional options for controlling how the plots are shown. The 

foreground and background colours for the plots can be set here among other options. 
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3.1 IMPORTING DATA FOR GRAPHS 
In order to plot graphs (see X-Y plots, §2.14) the data to be plotted needs to be imported into 

ViewZ. This may be done using the Import Data for Graph command in the file menu. Clicking 

this command brings up a panel which allows 

one to browse and select the data file from 

disk. If the data file is a ViewZ generated file 

then the File Type drop-down list must be set 

to ViewZ tabular data. ViewZ also supports 

plain tabulated data stored in a text file. These 

are files with multiple rows of data with each 

row having tab separated data. When opening 

such files, set the file type drop down to Pure 

tabulated data and specify the number of rows 

and columns of data in the file. 

The dependent and independent variables 

may be set in this panel itself. This may also be 

modified later. Click open to import the data 

file and add the X-Y plot to the plots list. The 

plot will also be rendered on screen 

immediately. 

3.2 DATASET TOOLS  
The Dataset menu contains tools that work on loaded datasets.  

3.2.1 EXTRACT DATASET 
This tool allows one to create new datasets from parts of a 

loaded dataset. Specifically, one may create surface 

datasets by extracting labels or boundaries a 3-D dataset. 

Invoking the Extract Dataset command in the Dataset 

menu brings up the corresponding panel which lists all 

labels and boundaries in the currently loaded dataset. To 

extract a label or a boundary, check-mark it in the list and 

click the OK button. A new surface dataset is then created 

and added to the datasets list (§1.4.1). 

3.3 USER PREFERENCES 
The Preferences panel in which may be invoked by clicking 

on the Preferences... command in the Edit menu has three 

tabs. The General tab has settings for: 

The default projection mode 

ViewZ will remember this as the default projection mode 

and all rendering will be done in this mode unless changed 

using the view menu command for switching projection modes. 

 

Figure 3.2 – Extract Dataset Panel 

Figure 3.1 – Extract Dataset Panel 
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Canvas background colour 

The canvas background colour may be changed by clicking the Set Canvas Background button 

which brings up a colour picker dialog box. 

Default mesh opacity 

The default opacity of the main mesh plot 

(§2.3) may be set using this slider. 

Help browser 

The HTML help pages need an appropriate 

browser which should be specified here. 

This field must contain the full path to the 

browser executable. If the browser location 

is specified on the system path variable 

then putting just the browser executable 

name would suffice. 

Recent Files 

ViewZ can remember few of the most 

recently used files and displays these under 

the Recent Files entry in the File menu. The 

number of files to remember may be set 

here. Clicking on the Clear button will clear 

this list. To turn off this feature, set the 

number to remember to 0. 

The Colour table tab in the preferences dialog allows customisation of the colour map used by 

the plots. The following options are 

available: 

Colour table type 

Set the colour map to either gray scale or 

to show multiple hues. 

Colouring 

This may be either smooth or banded. If 

banding is desired, set the levels or 

number of colours to use. A minimum of 

8 levels must be specified. 

Custom Min-Max 

By checking the Enable custom min-max 

check box, it is possible specify a custom 

range for the scalar field values. All plots 

that are coloured by such a scalar will be 

displayed with colour variations only for 

the set range. For values outside of the 

set range, the extreme end colour is used.   

The Dialogs tab has settings that allow 

Figure 3.3 – General properties 

Figure 3.4 – Colour table properties 
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one to configure the behaviour of certain dialog boxes and panels in ViewZ. The Confirm before 

closing checkbox may be unchecked to disable the confirmation message box that appears each 

time some dataset has to be unloaded from ViewZ. 

The last tab on the preferences panel is 

OpenGL and it lists some basic 

information about the graphics subsystem 

and OpenGL extensions supported. 

 

3.4 LINE PROBE 
Available for 3-D structured datasets, this tool allows 

extracting points from a dataset with associated field 

values at those points as a smaller generated dataset for 

visualisation. In the current version, ViewZ supports 

displaying vector glyphs (§2.9) on such generated 

datasets. 

The line probe tool extracts points on a straight line 

specified using the Line Probe panel available from the 

Data Probe menu. The probe can insert points along the 

line terminating at boundaries or between the start point 

and a boundary. This is controlled by the Point insertion mode radio buttons (figure 3.6). If the 

Fixed points between boundaries radio button is selected 

the points are inserted along the line terminating at 

boundaries. If the Fixed Points radio button is selected, the 

points are inserted between the start point and a 

boundary. 

Once the line is specified and the point insertion 

parameters specified, click the Add/Modify button to find 

the points. A message box will provide information about 

the number of points inserted. At this point a new entry 

will be added to the datasets list (§1.4.1) of type Line 

Probe. 

3.4.1 CREATING TABULAR DATA FILE 
On clicking Done the option to save the point data to a file 

as ViewZ tabular data will be available. If Yes is selected, 

the Write Probe to File panel appears. In this panel a save 

file path can be specified and the scalars to be written to 

disk may also be specified. To click the Write button to 

write the file to disk and click Close to close the panel. 
Figure 3.7 – Specifying Line 

Probe 

Figure 3.6 – Point insertion mode 

Figure 3.5 – Confirm Close check box 
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3.5 LINE ON SURFACE PROBE 
The Line on Surface Probe is similar in function 

to the Line probe in the previous section with 

the difference that the line in this case lies on a 

surface instead of the volume of the dataset. The 

panel for this probe allows one to select 

surfaces from among the labels and boundaries 

in the dataset on which to place the line. The 

line itself may be specified either using the 

mouse or by specifying a plane that intersects 

the surface in which case the line of intersection 

is used. 

To use the mouse to specify the line, select the 

Using Mouse radio button in the Probe Options 

tab and click on the Start button. Click on two 

locations on the target surface to specify the 

start and end points of the line and then click 

the Probe button to get the points. 

3.6 POINT PROBE 
Point Probe lets one see scalar values at specific user 

selected points in the dataset. This tool requires one to 

place a section and probe points on the section. Invoking 

the Point Probe command from the Data Probe menu 

brings up the corresponding panel. The probed points and 

values at those points are listed by this panel. Once the 

section is in place click on the Probe button and then 

double click at the required points on the section. Each 

time the point under the mouse is probed and it’s values 

listed in the panel. To stop the process, note all the 

required values and click on the Finish button. This will 

also close the panel. 

 

Figure 3.8 – Line on Surface panel 

Figure 3.9 – Probed Points and 

data 


